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1. Working with Magi-Cut V12 Express

Y

A The Magi-Cut V12 Express program is a simple and straightforward way of generating cutting
patterns for a cutting list. It is designed for the smaller workshop using a sliding table saw or vertical saw and
is focused on producing efficient cutting patterns from lists of part sizes and available materials (boards).

It is Windows software running on a single PC at a time.

Express - at a glance

UNIT-BASE MEL-CHIP-18MM 555.0 x 470.0 25

UNIT-DREWE MEL-CHIP-1S5MM S70.0 x 555.0 22

CAR-FLINTH TEAK-ITAM-I15MM 425.0 x 150.0 18 * |

CaRl -RACK TEAK -IAM-15MM 710.0 x 205.0 Z§

UNIT-DOOR HMEL-CHIP-15MM 620.0 x 425.0 16 | |
BRD/01 MEL-CHIP-18MM 2440.0 x 1220.0 250 | | I

BRD /02 TEAK-LAM-18HHM 3050.0 x 1220.0 424
This is how to work with Express:-

» Create a New cutting list

» Enter the part sizes, material and quantities required
 Enter the available board sizes

Or Import the part details from file

Optimise
» Review and print/export the results
» Use the Cutting instructions to set the saw

What is Optimising?

The aim of the optimiser is to produce the most efficient patterns in terms of cost. This depends on:-
- Cutting list sizes

- Constraints on cutting (trims, saw blade thickness)

- Board sizes available

- Material costs

The process of optimising weighs all these factors and produces a set of cutting patterns.

A tour of Magqgi-Cut V12 Express

As an introduction to the software we enter a cutting list, optimise it, and look at the results.
If Express is not yet installed - look at the section: 'Setup (install)’

(It may be helpful to read through this guide before installing the software to become familiar with the overall
operation of the program).



X

Magi-Cut

Yk To run the program click on the icon on the desktop

The first screen is the 'Splash' screen which appears for a few moments.

EXPRESS

The program moves automatically to the Main screen.
Main screen

This is the command centre of the system. Access all the options and choices from here.
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Note - A set of demonstration data is included when the program is setup.

At the far left is a stacked ToolBar (Shortcut Bar) giving quick access to each section of the program.
At the centre left is a tree/index showing the various options and existing data.

There is also a top toolbar and menu options to access all the other program features.

The other section of the screen optionally shows an information panel and a pane showing the contents of
the currently selected file, for example, a cutting list.

Measurement mode - The program works in millimetres, fractional inches, or decimal inches. The
operation of the software is the same in each case except that fractional inches are displayed and entered in
fractional format (44 x 61-1/4, 96 x 48-1/2).

This tour uses: Millimetres.

Note - arrange the screen to suit your way of working with the View menu option and by adjusting the size of
each pane with the mouse (place the cursor at the edge of a pane to display the grab handles).

First time - If using the software for the first time - check the Serial number is correct and click on the Licence
button to check the details of the software licence agreement. These are options on the Help menu (Help -
About, Help - Licence agreement)

Enter a cutting list

To enter a list of sizes:-

At the tree open up the 'Cutting lists' branch (click on the + symbol).



------ Cemo multiple boards

...... Demno part edging
...... Demo part graining

» Double click on the New... option
The program moves to the Cutting list screen and shows a new blank list.

At the 'Title' box enter a title for the list.

2 Cutting list - [m] X
_E\Ie Edit View Optimise Help
PDOOBB s %@ &2
Title Parameters
Parts
[Drezcription b aterial Length ‘width Quantity Grain Edage Infa 1 Info 2 Info 3
Global |
il
Z
3
4.
5.
E.
[
.
Boards
Board I aterial Length Width Thickness Infarmation Guartity Cost Grain
Global
il
2
g,
4
MNUM
(If the 'Title' box is not visible - select: View - Properties to switch on the Title box)
* Move to the line labelled 1 in the 'Parts' section (use the mouse or Tab)
» Enter the part details including the quantity required
The details to enter for each part are as follows:-
Description - Any code or short description of the part.
Material code - A code for the board material to use for that part.
Magi-Cut V12 Express uses this to match up the parts with the available boards in the board list. Each board

size and material needs a unique code. For example:-

MEL-CHIP-18MM (melamine faced chipboard 18mm thickness)
MED-DEN-FIBRE-18 (medium density fibre board 18mm thickness)

Sizes - the length and width of the part.
Quantity - the quantity of the part required for this job




Grain - the material grain of the part

Y - grained
N - no grain
X - grained

White melamine typically has no grain but Teak laminate is grained. The program uses the grain setting to
make sure that each part is correctly laid out on the board and where the grain needs to run along the length

(part can be placed either way)

of the part it does so.

(grain runs with length of the part)

(grain run across the width of the part)

Global line - the line at the top of the list is called the global line. This can be used to provide a common

answer for every part in the list for a given field - in this example the over and under percentages are set to 0

percent for all parts as they are not used in this tour.

After entering a few sizes the 'Parts' section should be similar to the following.

Parts

Dresciiption

Material

Length

Yfidth

Quantity

Grain

Edge

Info 1

Info 2

Info 3

Global

BTH-CAB-BACK

MFC18-TEAK

EE4.0

564.0

000

BTH-CAB-BACK

MFC18-EBONY

464.0

564.0

0ooo

BTH-CAB-BOTTOM

MFC18-EBONY

464.0

1440

0oog

BTH-CAB-BOTTOM

MFC18-TEAK

EE4.0

144.0

000

DDC-BOTTOM

HARDBOARD -dbid

S64.0

564.0

0ooo

BTH-CAB-DOOR-LEFT

MFC18-TEAK

3445

450.0

0000

BTH-CAB-DOOR-LEFT

MFC18-EBONY

2435

460.0

0oog

BTH-CAB-DOOR-RIGHT

MFC18-TEAK.

3435

450.0

000

Wwlo |~ O Wb

BTH-CAB-DOOR-RIGHT

MFC18-EBONY

2435

450.0

0ooo

10 BTH-CAB-END-LEFT

MFC18-TEAK

1620

6000

S R R R S N S AN RN

z|l=z|lz|l=z|l=z|=|=z|=|=| =

0000

We can now enter some board sizes.

* Move to the Boards section (click on row 1 with mouse or Ctrl Tab)
+ Enter details of the available boards

At the cutting list the material codes used were:-

MFC18-TEAK
MFC18-EBONY
HARDBOARD-4MM

The details to enter for each board are:-
Board - a board code or description
Material - a material code

The program uses this to match up the parts with the available boards in the board list. Each board size and
material needs a unique code

Sizes - the length and width of the board

Information - any extra details about the board (e.g. supplier, quality)
Quantity - the number of each board size in stock

Cost - the cost per square area (metre) of the material.

Enter an accurate cost as the program uses this to assess the pattern layout.
Grain - the material grain of the board

Y - grained

N - no grain
X - grained

(grain runs with length of the part)
(part can be placed either way)
(grain run across the width of the part)



a
Boards
Board Material Length Width Thickness Infarmation Quartity Cost Grain

Global

1. | MFCI8-TEAK/M MFC18-TEAK 24400 12200 180 2 |y

2. | MFC18-TEAK/DZ MFC18-TEAK 20500 1525.0 180 22 1|y

3. [ MFC18-EBONY/0 MFCT18-EBONY 30500 1525.0 180 20 5760 | Y

4. | MFCTE-EBONY /02 MFC18-EBONY 24400 12200 180 28 210 |

5. | HARDBOARD-dbM./01 HARDEDARD -dbdM 24400 12200 40 a0 0830 | N -

Save the Cutting list

When data entry is finished - save the cutting list. To do this:-

- Select the Save symbol
The program prompts to save the cutting list to a file.

* Enter a file name

Save As >
File Dremo large list
Title Ewample of large cutting list
Meazurement mode millimetres

] Help Cancel

» Select OK to confirm the save
Note - the title can be changed here if necessary

Import - cutting list

In the cutting list program, there is an Import option (File menu and toolbar icon). Selecting this will bring up a
dialog showing all the files in the current path. The path can be changed via the Change path button at the
top of the dialog. Importing the data can provide an alternative to inputting all of your cutting list data
manually.

An Import file can be either a text based file (CSV) or an Excel file (XLS or XLSX).

Once afile is selected and the Ok button is pressed the following dialog will appear as follows:



| Import - Cutting list x|
Parts
Describe the data in your source e

Starting at the top of your file, how many header lines need to be skipped? 1]

Is your data separated by commas or another character? - please specify

Click required colimn headings and assign fo part fist felds

I aterial o |Description Length Wwidth Quantity Grain Edge:
1.|MEL-CHIP-18MM UNIT-END-LEFT 800.00 5E0.00 4 ] EOO0
2.|MEL-CHIP-18MM UNIT-END-RIGHT 800.00 5E0.00 4 1] 0e0o
3. |MEL-CHIP-18MM UNIT-BASE 564.00 5E0.00 4 0 EOO0
4 |MEL-CHIP-18MM UNIT-RAIL-REAR 964.00 9600 4 1] Rt
5. |MEL-CHIP-18MM UNIT-RAIL-FRONT 964.00 96.00 4 0 E/00
B |MEL-CHIP-18MM UNIT-BACK 964.00 £84.00 4 1] 0oog
7.|MEL-CHIP-18MM UNIT-DIYIDER 8E0.00 E34.00 4 0 0o
8 |MEL-CHIP-18MM UNIT-ADJ-SHELF 463.00 553.00 12 1] B
9.|MFC18-BEECH UNIT-DOOR 434.00 F14.00 16 1 EEBE

10.|MFC18-BEECH UNIT-PLINTH 364.00 80.00 8 1 0000
11| MEL-CHIF-18MM BU-EMD-LEFT 800.00 5E0.00 4 1] wO00

Previous Help Cancel

Note - If the wrong filename has been specified then the previous button can be used to go back and select a
different filename.

The first parameter is used to specify if there any header lines in the import file that need to be skipped.

The second parameter is what is the separator character (usually a comma, and disabled for Excel based
files).

At this point each relevant column can be assigned to a column in the cutting list. This is done via the combo
box at the top of each column. Once a column is defined it will turn cream coloured.

Once all the relevant columns have been specified, the Ok button can be selected and the file will be
imported in.

Notes:

- The column details will be stored and reused for subsequent imports so they do not need to be set the next
time.

- Excel imports will only import from the 1st sheet in the file.
- Import will automatically discern if a txt file is ASCIl or UNICODE based.
- The import process will utilise the current locale decimal separator and convert it to a decimal point.

Export - Cutting list

In the cutting list screen, there is an Export option on the file menu. If a cutting list is on screen and this option
is selected then the following folder selection dialog will appear:



| Change path et

Export

W Magi-Cut V12 Express
W Data
Export
Import |
Guides
> lcons
Images
SlideShow

Eolder: Export
Make Mew Folder Cancel

Once a folder is selected a CSV file named after the current cutting list will be generated in that location and
the following message will be displayed:

Export *

o Finished

Note - If the file already exists, then an overwrite Y/N dialog will be displayed first.
The format of the CSV would have lines as follows:
description,material,length,width,qty,grain,edging,fixed1,fixed2,fixed3

Note - the separator between each value is the same as the one specified for import cutting lists. The decimal
point for the length/width values is set based on the current PC's specific decimal separator.



Optimise
Once you have entered a cutting list you are now ready to optimise.

Along with the Part and Board sizes the program also requires values for the cutting constraints, for example,
the 'Saw blade thickness', 'Size of trims' etc. These are set via the 'Optimising parameters'.

There is a default set of parameters which the program uses automatically - these are used for this tour.
(There is a section on how to adjust the parameter values later in the guide).

At the cutting list screen:-

- Select the optimise symbol
This starts the optimisation.
A small window appears while the optimisation is in progress. Use Cancel to abandon the optimisation.
The program shows the results.
The first screen shown is an overall summary of the optimisation called the 'Management Summary'. The

optimisation results (a set of patterns) is also called a 'run' and this section of the program for looking at the
results is called 'Review runs'.

2 Review runs — a =
File Edit View Settings Summaries Help
PEBARE I > pgd®w?
Summaries
B, Management summary Example of part edging
M anagement summary Dermo Part edging
Revision 5 @ 14 Jul 2023 10046 : Optimised by Stephanie
g Description Quantity m2 m3 Percent Cost Statistic Value
e Farts produced 139 2473 043 83.07% Mumber of patterns g
Scrap 504 008 16.93% Headcut patterns 1
% Sheets used 10 2977 051 100.00% 9276 Rotated patterns 0
e Recut patterns 5
oard sumnmary
Edge K 8.3M Waste (%Parts)  2038%
ﬁ] Edge R 16.9M Waste (%Boards)  16.93%
Pattern zummary Edge T 109.5M
Edge W 32.5M
Input zummary
b aterial summary
B
B
Pattern preview
e 1+ \Management summary /

Once the optimisation is complete the results are stored and can be reviewed and printed as required.

The Management summary report shows the overall statistics for the run. For example:-
Number of parts produced

10



Number of boards used
Overall cost
Overall yield

Use the Navigation bar to look at the other reports.

TEADRE M4 D> dPIgE® ?

The other reports are:-

Part summary
Board summary
Pattern summary
Input summary
Material Summary
Run Summary
Pattern preview
Patterns

The stacked toolbar at the left can also be used to access the reports and to view the patterns.

] ]
sz

A thumbnail preview is shown.

- Click on the pattern preview symbol

X Revisw runs

Summaries  Help

4 4 > Pl = ?

File Edit

T QB é

View Settings

o

Drerno Part edging
Revision 5 @ 14 Jul 2023 10046 : Optimised by Stephanie

F anagement summary

Size:2440.0 x 1220.0

th

g Pin:l Board:1MFC16-TEAK/DL Size:2440.0 x 1220.0 Pin:2 Board:1.MFC18-TEAK/D1
Qty:1 Material MFC18-TEAK Qty:1 Material:MFC18-TEAK
Part summary kN L%
5] T 53] [5]] 50} T o] 5]
(=] (=] (=] (=] h (=] (=] (=]
S o +a o Y £ B o
Efa 1 1 1 1 2 1 1 1 1 2
Board
SRk Seq 64 564 564 564 Se4 Sed S6d
o |E i ¥ & w2 i ¥ &
ﬁ 0 3 Mo 3 fo 3 @O0 3 o 3 o 3 o 3 Jo 3
Pattern surnmary wn o ] wn E!DU| on wn [} ] o)} 6DD| (o)

Pt:3 Board:1.MFC1B-TEAK/DL Size:2440.0 x 12200

Pir:4 Board:1.MFC18-TEAK/D1 Size:2440.0 x 1220.0

et Qty:1 Ma\l'\terial:MFClEl—TEAK
e F o Fi B
ﬂ 0 664)~ ““sadl” =
- rJ G4 & &
M aterial summar - | |
b S eed|” 1leed” 12 P 12
= g g g
’ 1 1 1 12
Pattern preview
664 664 a64] 311

=

Qty:1 Material:MFC18-TEAK
A

o IE i % =
w3 o3 o3 o3
h in in in in
] 7] Too o o
~12 84 |54 [£4 [54
Ln L n n
n BE4E = =
S et 1lsed” 12 |7 12
o | o | odad o ]

The preview shows all the cutting patterns grouped by material code.

* Doubile click on a thumbnail to see the full pattern

11




2 Review runs

Summaries

~

b anagement summary

Eile Edit View Settings

LIF=ISN

Summaries  Help

A 4 > Pl e = ?
Pattern 5 of 8

Revision 5 :

Demo Part edging
14 Jul 2023 10:46 : Cptimised by Stephanie

b

Board: MFC18-TEAK/O1

Waste: 10.61%

Size: 2440.0x 12200 18.0

Part summary Material MFC18-TEAK Boards: 1
=) W
' [ “ J ] J Y
Board summary : % % % %
ﬁ 15 in n 4 Ln 4 in 4
564 :
Pattern summary = = 450 = 450 = 450 = 450
& I~ © -?3 © s
15 in in 4 in 4 in 4
Input summary |
263 450 ) 450 450] 450
Iﬁ — o] [] d
Material ﬁ 2 664 : : :
atenal summary = 15 15 i 15
L]
g = 664] 564 564 564
e o o G
allern preyview
n 8 664" 8 664" 8 664

-

Pattern

Saw blade thickness: 4.8
Rearrip trim (inc blade): 10.0 Rear crosscut trim (inc blade) 10.0 Retrim {inc blade) 5.0 Grain direction. =

4 » \Pattern A Parts £ Cutting dimensions /

The waste areas are shown with hash lines (or via a colour). The patterns can include recuts and head cuts

(as shown below).

12



2 Review runs

Summaries

~

b anagement summary

b

Part summary

5!

Board sunmimary

iy

Pattern summary

i

Input summary

-

Material summary

] B
] B

Pattern preview

-

Pattern

Eile Edit View Settings Summaries Help

PBARE A D Pl ?

Pattern 6 of 8

Demo Part edging

Revision 5 @ 14 Jul 2023 10:46 : Optimised by Stephanie

Board: MFC18-TEAK/O1
Waterial: MFC18-TEAK

»

Wiaste: 23.97%

Size: 2440.0x 12200 18.0

d01-9¥>-H14d
 dOL-9v¥D0-H1d

oy [ @ [ @ @ @ [ (¥ o
U_J| IR I REIERRIIZIR IR IR 2
£
32227777715 k)
6' 311 311
O | 144) 144] 144] 144] 144] 144] 144)194) BTH-CAB-TOP
BTH-CAB-TOP | BTH-CAB-TOP |[= 7

e 664
BTH-CAB-TOP | BTH-CAB-TOP
£ 7 664| £ g 664

Saw blade thickness: 4.8

Boards: 1

Rearrip trim (inc blade): 10.0 Rear crosscut trim (inc blade) 10.0 Retrim {inc blade) 5.0 Grain direction. =

4 » \Pattern A Parts £ Cutting dimensions /

The tab bar at the foot of each pattern shows the other pattern information, Part sizes and Cutting

instructions.

The cutting instructions are for a sliding table saw and can be used to set the saw for cutting.

13




2 Review runs - a *

Eile Edit View Settings Summaries Help

HBARE KA M ?

%\ Pattern 5 of 8

tanagement summary Dermo Part edging
Revision 5 @ 14 Jul 2023 10:46 : Optimised by Stephanie
g Cut Size Qty Part Cut Size Qty Par
o Main Trim 572 )
Trim 52 1 Crosscut 6640 1l
i_—?l, Rip 3495 2 Recut 1440 1 BTH-CAB-BOTTOM
e Trim 52 1 Recut 1620 1 BTH-CAB-SHLF-BASE
Crosscut 5640 1 Crosscut - 5640 3 DDC-SIDE-RIGHT
ﬁ] Recut 3o 1 DDC-SIDE-RIGHT Rip 1620 1
Crosscut 4500 4 BTH-CAB-DOOR-RIGHT  Trim 52 1
Fattetn summary Rip 311.0 1 Crosscut  664.0 3 BTH-CAB-SHLF-BASE

=

Input summary

-

Material summary

] B
] B

Pattern preview

-

Pattern

L Pattern {Fars ) Cutting dimensions /

Export - Summary

In review runs the file menu has an Export current summary sub-menu with the same options:

This enables you to create files that you can use outside of the software on a report by report basis.
PDF
XLS
XLSX

Selecting any of these will bring up the folder selection dialog and after export the following dialog will be
displayed:

" |

Export *

o Finished

™

The export filename will be named as follows:
<runname>-<summary name>.[PDF|XLS|XLSX]
e.g. basic cutting list-management summary.XLS

Exporting a pattern drawing to XLS or XLSX will create a <runname>-<ptnnum>.jpg file
14



Note - Export to XLS/XLSX files is not available for Pattern preview.

- select exit to leave Review runs
The program returns to the Main screen.
At the main screen open up the 'Optimisations’ branch of the tree. The recent optimisation is now in the list.

This run can be reviewed at any time by selecting the item.

Note - if the parts or boards are changed after an optimisation the results are no longer valid and the lists
should be optimised again.

Export - run
On the main menu under the file menu there is an Export Runs sub-menu with the following options:

PDF
XLS
XLSX

This enables you to create a number of files in one go that can be used outside of the software (these are
similar to the files you can export from within review runs individually).

After selecting one of these a dialog will appear to select a run and after the run is selected the following
dialog is shown from where you can select which summaries appear in the export file.

Export *

Summaries

B # anagement summary
B Part summary

B Board summary

B Pattermn summary

B Input surarmary

B M aterial summary

B Pattemn drawing

[ ] Preview

Help Caricel

Initially this dialog will have all the possible summaries for the export type checked, but if any are unchecked
then the next time export runs is done, it will reflect those changes.

After this dialog is the folder selection dialog and after that the export takes place and the following dialog is
displayed.

15



Export ot

o Finished

e

A PDF, XLS or XLSX file will have been generated in the folder selected for the selected run.

The PDF file will have page breaks between each report. The excel files will have summaries on separate
sheets and the folder will also contain JPG files for the pattern drawings.

These JPG file will be names as follows:

<runname>-<ptnnum>.jpg
e.g. Basic part list-0001.jpg

End of Tour

The tour above has shown the principal operations of Magi-Cut V12 Express and how to use it. The later
sections give more details about the program.

16



2. Setup (install)

Magi-Cut V12 Express is downloaded as a single file named:-
Magi-Cut V12 Express Setup.exe
- Click on this program to start the setup.

Follow the setup (install) instructions carefully. When finished the software and demonstration data is ready
for use.

The Setup program displays the first screen:-

Magi-Cut V12 Express Setup x>

210

Welcome to the Setup Program for Magi-Cut ¥12 Express

It iz strongly recommended that pou exit all Windows programs befare running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs you hawve running. Click Mest to continue
the Setup.

1 ¥ |
! | Cancel !

The above screen is NOT shown if the program is already installed on the PC.

Instead the program prompts to update/repair the existing installation.

17



Magi-Cut V12 Express Setup >

Tz ez pii=]e]
b

» Select Next to continue (Cancel to abandon)

18



Magi-Cut V12 Express Setup

Licence Agreement

Software Licence Agreement

Magi-Cut Software Limited {“Magi-Cut”), 5t. Brandon's House,
29 Great George Street, Bristol BS1 50T, United Kingdom

THIS LICENCE TO USE THE SOFTWARE 15 GRANTED OH COHDITION THAT YOU
COHTINUE TO ACCEPT AHD

OBSERVE THE TERMS OF THIS AGREEMENT.

In thiz Agreement, the term "Softvware” means any or all module(s) of the MAGI-CUT %12
EXPRESS computer software andfor Updates for which you have purchazed licenceis),
tocethier with related product manuals, online activation and all new releases and revisions
of such software and manuals which may be supplied to vou under applicable warranty or
support services, "Updates" shall mean any improved version of the Software supplied to
wau under this agreement that Magi-Cut may from time to time make available with a
different release number.

+ | accept the licence agreement | Frirt

| do not accept the licence agreement

i < Back II Mexts | i Cancel

The screen shows the Licence agreement for the UK. Use the scroll bar to navigate up and down the
document (use Print to make a copy)

» Check the radio button to accept the agreement

The agreement must be accepted for setup to continue

» Select Next to continue

19




The next screen shows the version number and minimum hardware requirements for the program (use the
Print button to print a copy - if required).

Magi-Cut V12 Express Setup X

Heleaze information

2

’

Pleaze read the following important releasze information

Magi-Cut W12 Express
1-Jun-23

W12.00.0 - Full releaze
Reference: 9686

WWelcome to Mag-Cut 12 Express - the cutting pattern optimiser far sheet maternials.

- Express can optimize a list of up to 2000 pieces to be cut from a variety
of materials and sheet sizes.

- Part sizes, quantities, grain, and board zizes can be entered by kepboard
or pasted from a spreadsheet.

W

Frirt

£ Back H et = | Cancel |

» Select Next to continue

20



Then you will be asked for the location you wish to install the software (the default is shown)

To select another folder use the Browse button.

Magi-Cut V12 Express Setup

Choosze Destination Location

Select folder where setup will install files.

' I k ‘ Setup will inztall Magi-Cut W12 Express program files in the following folder.

| . . . To inztall to this folder, click Mest.

- ' ‘ |E:'\Magi-|:ut W12 Express

Browsze...

£ Back et = Cancel

» Select Next to continue

The installer will then prompt you for the program group name (again the default is shown).

21



Magi-Cut V12 Express Setup

Select Program Folder

Pleaze select a program folder.

Setup will add pragram iconz to the Program Faolder listed below. *fou may wpe a new folder name,
aor zelect one from the existing folders list. Click Mext to continue.

Program Folder:
|Magi-|:ut W12 Express

Exizting Folders:

M agi-Cut Modular W11.04 1T1 -
b agi-Cut Modular W82

Magi-Cut Modular W26

hagi-Cut Modular W3 DEVIE

Magi-Cut Modular V3 SOL DEWVI3

M agi-Cut Modular W3 S0L DEV14

hagi-Cut Modular %3 SQL DEY1S

M agi-Cut Modular 9.07.2

b agi-Cut Modular V3.081

M agi-cut Software Ltd

b agi-Cut Trial 411

N5Hele ¢ Back | | Mt Cancel

» Enter the name for the program folder (if required) or select a different folder.

» Select Next to continue
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The Setup program proceeds with the installation.

Magi-Cut V12 Express Setup >

Tz ==

ke
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When Setup is finished the final screen is displayed.

Magi-Cut V12 Express Setup

Setup Program Complete

|
r

< Back | | Cancel
+ Select Finish to close the Setup program
The program displays the program group.
= | Magi-Cut V12 Express — a x
Home Share e %
:
uk <« Windows » Start Menu » Programs » Magi-Cut V12 Express v O Search Magi-Cut V12 Express @
# Quick access 2 Mame Date medified Type
I Desktop o+ a1 Guides 1470772023 11:25 Shortcut
& Downloads P ';@ Help for Magi-Cut V12 Express 14/07/2023 11:25 Shortcut
e o % Magi-Cut V12 Express 14/07/2023 11:25 Shortcut
g ' 2| Readme 14/07/2023 11:25 Shortcut
= Pictures - - "
#n System check 14/07/2023 11:25 Shortcut
=2 G * ,‘J www.magi-cut.co.uk 1470372023 11:57 Internet Shortcut
e Windows8_05 (C) -
Data
tasks
V8-English
v o€ >
6 iterns 'F

A shortcut is installed on the desktop and the program group is added to the Windows 'Programs' bar (at the
Windows 'Start' button)
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Magi-Cut Express
Guides
Help for Magi-Cut Express
Magi-Cut Express

Readme

System check

* Close the program group

Note - To uninstall use the Add/Remove (Program features) option at the Windows control panel. There is no
option in the program group to remove the program.

Security - For the trial version the first screen shows the remaining days for the trial; there are other options
for purchasing the program. Press the 'Continue’ button to move to the main screen. For the purchased
system the program moves directly to the main screen; it is protected by a software licence.

Program does not run

If the program does not run there are only a few main causes.

- Program was not installed correctly

- Hardware is below minimum requirements

- The Trial version has expired (it runs for a limited number of days)

Program setup problems

It may be the program setup failed (this is quite rare unless the setup was cancelled)
- Re-try the install (in this case install to a different location on the PC)
The state of the program can be checked (if the Setup finished Ok) by running the 'Check’ program.

Use Windows Explorer to move to the program directory (where the program was installed e.g. C:\Magi-Cut
V12 Express).
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Mame Date modified Type
Data 14/07/2023 11:25 File folde|
Guides 1470772023 11:25 File foldel
lcons 1470772023 11:25 File foldel
Images 1470772023 11:25 File foldef
SlideShow 14072023 11:25 File foldef

2 Backup.exe 14/07/2023 09:54 Applicati)

2 Batch.exe 14/07/2023 09:54 Applicatil

|j Bsrgui.dll 14/07/72023 0%:54 Applicati

|:| Bsrlib.dll 14/07/72023 09:54 Applicati
|J Bsrmch.dll 14/07/2023 09:54 Applicati

;_1, fromnamc 14/07/2023 09:54 Applicati

X check.exe 1470772023 09:57 Applicati

[=] Cl2hb.dll 14/07/72023 09:54 Applicati

2 CloudSeats.exe 14/07/2023 09:54 Applicati

|J dls2dun.dll 14/07/72023 09:54 Applicati

|j Dlsbarun.dll 14/07/72023 0%:54 Applicati

Double click on the program 'Check.exe' to run the system check.

Alternatively select the 'System Check' option from the Program group on the Windows 'Start' button.

. Magi-Cut Express

Guides

Help for Magi-Cut Express
Magi-Cut Express

Readme

System check

Help

If there are problems running the program the help can still be accessed. To do this:-
Move to the directory where the program is installed

Double click on the program 'Check.exe' to run it
Click on the Help button (this is the full help for Magi- Cut V12 Express)
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Minimum hardware

The program does NOT run on any PC below the minimum specification. The minimum specification is:-

- Processor speed 2Ghz
© Memory 2Gb (400Mb free)
Hard disk 20GB free
Display 1440 x 900 or higher

The supported operating systems for this version are:

- Windows 8 (32bit and 64bit versions)

- Windows 2012 Server x64 Editions

- Windows 8.1 (32bit and 64bit versions)
- Windows 2012 Server R2 x64 Editions
 Windows 10 (32bit and 64bit versions)
- Windows 2016 Server x64 Editions

- Windows 2019 Server x64 Editions

- Windows 11

- Windows 2022 Server
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3. Parameters

For effective optimising the program should be set up to allow for the correct measurement mode, saw blade
thickness, and trims etc. These parameter values can vary for different jobs and between companies.

Use the 'Parameters’ options to set these values.

The parameters are set to reasonable default values when the program first runs but it is important to check
all these values and adjust them where necessary to reflect your way of working.

There are only a few parameters to consider.

System parameters

These are basic settings for the program. At the main screen:-

» Select: Parameters - System parameters

2 Systemn parameters >

Gaeneral Help view ==

Measurement mode

Measurement mode
Metric (0.0 - 9299.9 mm

Decimal inches {0,000 - 999,999

ONON -

Fractional inches {0 - 933-a3/64)

Company nanme

Express Daka

Prink Help Cancel

+ Select the measurement mode to work in.

For most users this is typically Millimetres.

» Enter a name for the Company

This name is shown on the screen and in the header/banner of most printed reports.

Note - These parameters are usually only set once and rarely need to be considered again.

Optimising parameters

Optimising parameters are important as they set the saw blade thickness, trims and type of cutting allowed.
To adjust the default values for the optimising parameters, at the main screen:-

» Select: Parameters - Optimising parameters
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2 Optimising parameters - Default Optimising Parameters
Trims  Rules

Sek the parameters For trims

Range
0-999
Millirnetres
Saw blade thickness
Rip and crosscuk
Minirnurm rip krim {inc saw blade thickness)
Fronk 10,0 s Rear
Minirum crosscut Erim (inc saw blade thickness)
Front 10.0 Rear

Retrim after head cut {inc saw blade thickness)

5.0

s

Help view ==

Saw blade thickness: Rip and crosscuk

Prink Help Cancel

Work through the values on the first page and set the required values for the saw blade thickness, front and

rear trim, and retrim value.

The picture at the right gives an overview of what the parameter does (select Help for further details).
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The second tab shows the 'Rules'. These can be used to set the cutting style.

2 Optimising parameters - Default Optimising Parameters *

Trims  Rules Help view ==

Sek the rules For cutting e :
ecuts: Mulkiple - unequa

Recuts
Main Multiple - unequal ~
Head Multiple - unequal - T T—
NN
Head cuts k
NN
Quankity 2w |
%\\\\\
Board orientation Lengthways - \
&.\.\xx\\\'
Prefer re-usable waste ] |

Prink Help Cancel

For example, recuts can limited to 'single recuts only' and the number of head cuts allowed can be restricted
to"1".

These default values apply to all optimisations BUT there is also an option to adjust the values for each
cutting list (at the cutting list screen). This is may be necessary, for example, to change the trims for one type
of material, or to set 'no head cuts' for an optimisation. To do this:-

- Move to the required cutting list

Title Example of bazic cutting list
Parts
Dezcription hd aterial
al MAPLEWOOD-18kM
PRT-007-A MAPLEWOOD-18k M
PRT-002-B MAPLEWOOD-18k M
PRT-003-C MAPLEWOOD-18k M

- Click on the parameters button

The program displays the Optimising parameter screen (for the cutting list)
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2 Optimising parameters - Demao cutting list
Trims  Rules

Sek the parameters For trims

Saw blade thickness
Rip and crosscuk
Minirnurm rip krim {inc saw blade thickness)
Fronk 10,0 s Rear
Minirum crosscut Erim (inc saw blade thickness)
Front 10.0 Rear

Retrim after head cut {inc saw blade thickness)

Range
0-999
Millirnetres

Help view ==

Saw blade thickness: Rip and crosscuk

10.0 o
10.0 o
5.0 o5

Prink Help Cancel

s

- Adjust the required values

Any changes (at the cutting list) only apply to the cutting list chosen
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4. More about Cutting lists

There are several options for searching, sorting and for changing the view of the cutting list.

2 Cutting list - Dema cutting list = O X
Eile Edit Wiew Optimise Help
+
oo B =
TDOBE & R oo ?
Title Ewample of bagic cutting list Parameters
Parts
Description aterial Length width [uantity Grain Edge Infa 1 Info 2 Info 3
Global MAPLE'WODD-18hk
i PRT-001-4 | MAPLEWODD- 18k 1200.0 72h0 (N oooa
2 PRT-0028 | MAPLE'WODD-18hk 1250.0 G00.0 2N oooa
& PRT-003-C | MAPLEWODD-18kM 790.0 4500 3N oooa
4. PRT-004-D | MAPLEMWOOD-18kM 580.0 200.0 (N ooaa
5 MAPLEMWODD- 18k
Boards
Board Material Lenath Width Thickness Infarmatian Guantity Cost Grain
Global
1. | MAPLEWOOD-18hk 01 MAPLEWOOD-18kM 28600 1526.0 18.0 42 2340 | Y
2
MLk

These options can be useful when dealing with larger lists or where not all the fields (columns) are required.
Find
To locate an item in the list (for example, a part description or material code).

 Click on a cell in a column
 Select: Edit - Find (Ctrl F)

The program displays the Find dialog.

Find x
Find what: MAPLEW/CQOD-18MM | Find Mexk
[ IMatch whale cell only Direction Cancel
[ IMatch case Up
o Do
Search Current column w

» Enter text to search for
+ Select the [ Find Next ] button

The program moves to any found items.

The search is only for the current column and only applies to the list the cursor is located in; Parts and
Boards are searched separately.
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Sort
The list can be sorted by material, or by length, or by a combination of these. At the Cutting list screen:-

* Move to the 'Parts' section
» Select: Edit - Sort

The program displays a dialog to select the part fields to sort by.

Sort - Select cutting list fields *

[t aterial

[ | Length
[CIWidth

[ Quantity
[ Grain
[]Edge codes
[IInfa 1
[Cnfa 2
[Jinfa 3

k. Help Cancel

» Check a box to select a field

The sort can be based on more than one field.

+ Select OK to confirm

Note - A sort can also be applied to the Boards section (move to the Boards section and select: Edit - Sort).

Save and Copy lists

In some cases it is useful to save an existing list and use this as the basis for a new list. For example, where
many of the part details are the same but the quantities are different. There are two ways of doing this.

Save As
» Select: File - Save As
The program prompts for the name of the new list.

Take care when using this method because if the existing list is already optimised opening a list gives the
warning message:-

Patterns exist - changing list deletes patterns
It is Ok to open the list but make sure no changes are made.

Merge lists

» Create a NEW cutting list:-
* Move to the first line
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» Select: Edit - Merge

The program prompts for the name of the cutting list to merge in.

Merge X |
File Title [uantity
1| Demo multiple boards Example of multiple boards |
2
3
4
4]
E
7
k. Lizt Delete Print Help Cancel

» Enter the list name (or use the List button to select available lists)
» Enter the quantity of the list to merge in.

The merge applies to the Parts section and Boards section separately. Move to the Boards section to merge
in Boards (Edit - Merge).

Note - Merge can also be used to add one list to another.

View menu

Use the View menu to alter the style and appearance of the cutting list
For example, to hide columns:-

» Select: View - Columns

34



View cclumns e

B Grain
B Quick edging
B Infa
B nfa 2
Binfo 3

Help Cancel

* Un-check a column to hide it.

In the example below 'Grain' and 'Quick edging' columns are hidden.

X Cutting list - Demo cutting list - [m]

File Edit View Optimise Help

PR s X B =2
Title Example of basic cutting list Parameters

Parts
Desciiption Material Length Width Quantity Info 1 Info 2 Info 3
Global 1
1 PRT-0014 MAPLEWOOD-18MM 12000 7250 8
2 PRT 0028 MAPLEWOOD-18MM 12500 E00.0 2
g PRT003C MAPLEWOOD-18MM 7300 4500 3
4 PRT 0040 MAPLEWOOD-18MH 520.0 2000 E]
5 MAPLEWOOD-18MH
Boards
Board Material Length Width Thickness Infomation Quanlity Cost Grain

Global

1| MAPLEWOOD-18MM/01 MAPLEWOOD-18MM 25500 1525.0 120 42 2340 |y

2

Edit Parts and Boards

The Cutting list operates like a spreadsheet. Use the standard 'Windows' options to cut and paste data.
These options are on the Edit menu.

Edit - Cut (Ctrl X)
Edit - Copy (Ctrl C)
Edit - Paste (Ctrl V)
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Edit - Undo (Ctrl 2Z)
Edit Clear (Del)

Edit - Insert line (Fo0)
Edit - Delete line (F7)

Cells, rows or blocks of data can be copied. When copying more than one cell make sure that the selected
block and the area to copy to match exactly in terms on the number of columns and rows.

It is also possible to copy data from an external spreadsheet. In this case the columns in the spreadsheet
must match the columns as set in the Cutting list. For example:-

A ] C D E P G
1 JPRT-001-& PMAPLEYYCOD-15RAM 1200 725 8 M
2 JPRT-002-B MAPLEMOOD-18MAM 1250 &00 2N
3 fRART-003-C MAPLEYWOOD-15MM 730 430 3 M
4 JPRT-004-D MAAPLEWOOD-12MAM
7)
]

The data can be pasted into a new or an existing cutting list.

X Partlist - O

File Edit View Optimise Help

FTOOER R E & ?

Tite [ Parameters |
Farts
Description M aterial Length ‘width Quantity | Grain Edge Info 1 Info 2 Info 3
Global
i FRT-001-4 MAPLEWOOD-18MM 12000 725.0 8N
2 FRT-002B MAPLEWOOD-18MM 12500 £00.0 2|N
& FRT-003-C MAPLEWOOD-18MM 750.0 450.0 3N
4. FRT-004-D MAPLEWOOD-18MM 580.0 200.0 8N
5.
B.
7.
8.
&)
1o
Boards
Board b aterial Length width Thickness Information Quantity Cost Grain

Global

1. | MAPLEWOOD-18Mb /01 MAPLEW OO D18k 2550.0 | 15250 18.0 42 2340 Y

2

NUM

Note - if copying from the program to a spreadsheet any hidden columns are automatically included in the
copy - allow for this in the spreadsheet format.

Global line

The Global line is the line at the top of the list of Parts and list of Boards.
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X Partlist - ]
File Edit View Optimise Help
+
oo B =
TP & % oo ?
Tie [ Poraretes |
Parts
Description ‘___,.-——'HETEI'H——-.___‘Length Width Quantity | Grain Edge Info 1 Info 2 Info 3
Glabal MAPLEWOOD-18kM|
. B
i PRT-007-4 Tk ——"""  1200.0 725.0 an
2 PRT-002B MAPLEWOOD-18MM 1250.0 500.0 2N
& PRT-003-C MaPLEWOOD-18MM 7300 450.0 3N
4. PRT-004-D MAPLEWOOD-18MM 580.0 2000 AR
& MAPLEWWOOD-18k M
[ MAPLEWO00D-18MM
. MAPLEWO0D-18k M
n RAADH Ty dOmm A 0kARd
Boards
Board aterial Length ‘width Thickness Infaormation Quantity Cost Grain
Global
1. | MAPLEWOOD-18MM /M MAPLEW 00D -18MM 28500 [ 15250 180 42 2340
2
NUM

If there is an entry in this line the entry applies to every item in the list. This saves typing effort where the
value is the same for every part, for example, if all parts are the same material. The lines below the global

line are greyed out and cannot be changed.

To remove a global entry; delete the entry at the global line and move off the cell.

Print - Cutting list

To print the current list:-

» Select: File - Print (Ctrl P)
or

—

=

The program prompts to choose the data to print.

Select the ToolBar option

Print

B Board:

[ Print grid lines

Help Cancel

- Check the options to print parts, boards or both.
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The following example shows a print including Parts and Boards.

Express Data Mani-Cut %12 Express Friday 14 July 2023 1417
Cutting list
F ef:
HNa Deszcription haterial Lenath Miidth  Quantity Grain Edage Infa 1 Infa 2 Infa 3
Tl AP LEWO O D15 i b
1. PRTOO1-A 12000 F2h0 2 M aooo
2. PRTO0ZB 12500 G000 2 M aooo
2. PRTOO0ZC Fa0.n 480.0 3 M aooo
4. PRTO04D S30.0 200.0 2 N aoaa
Board list
Mo Board haterial Lenath Wi dth Thickness Information Quantity Cost Grain
1. MAPLEWDOD-18hihd 0 hAAR LEWIOOD-13hAhd 28500 1525.0 18.0 42 2340 W

The other Print options are:-

* File - Print preview (view the printout on-screen before printing)
* File - Print setup (change paper size, orientation, etc.)

Using Board list with Merge

Where there is a fairly standard and limited set of board sizes it can be useful to set up a full list of boards in
a cutting list and use Merge (at the Board list) to copy the list of boards into other cutting lists as required.

To do this:-

» Select any cutting list

» Select: Save As

* Enter a name for the new list
(for example, 'Standard')

- Enter the standard board sizes

At any cutting list (boards section) where some or all of the standard boards are required select 'Merge' to
merge in the 'Standard’ list. Adjust the quantities or boards available as required.

It does not matter if the standard list contains boards with materials that are not in the parts section - these
boards are ignored.

5. More about Review runs

The 'Review runs' options are used for looking at the cutting patterns (optimising results). They show a set of
summaries, the full set of patterns and cutting instructions.

To look at any optimised run, at the main screen:-

* Open the 'Optimisations' branch of the tree
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* Double click on a run to view it.

The first report shown is the Management Summary

2 Review runs

e

Management summary

s

Part summary

Board zummary

iy

Pattern summary

tn

Input surmrary

=

M aterial summary
] B
] B

Pattern preview

-

Pattern

Eile Edit View Settings Summaries Help

B B8

Management summary

44> PlgEE?

Demo Part edging
Revision 6 : 14 Jul 2023 14:23 ;. Cptimised by Stephanie

Description Quantity m2 m3 Percent Cost Statistic Value
Parts produced 139 2473 043 83.07% Mumber of patterns g
Scrap 504 008 16.93% Headcut patterns 1
Sheets used 100 2877 051 10000% 9276 Rotated patterns 0
Recut patterns 5
Edge K 5.3M Waste (%Parts)  20.38%
Edge R 16 .9h Waste (%oBoards)  1693%
Edge T 109.8M
Edge W 32 5M

4 » \Management summary /

Use the navigation options and/or the stacked toolbar at the left to see the other reports and patterns.

Customising reports

Each report can be customised. The items that can be changed are:-

- Report content

- Report format (font style and size)

- Report layout (column widths, grid lines etc.)

To customise the 'On-screen' report:-

* Move to a report (e.g. Part summary)

39



2 Review runs

Summaries

Management summary

Board zummary
Pattern summary

Input surmrary

I

M aterial summary

B B
] B

Pattern preview

-

Pattern

Eile Edit View Settings

PE AR

Summaries  Help

44> PlgEm?

Part summary

Demo Part edging

Revision 6 : 14 Jul 2023 14:23 ;. Cptimised by Stephanie

No Part/ Length Width Total m2/! Total Material cost Material cost
Description mm mm Prod Part m2 {Part Total
Total 139 2473 9276
1. BTH-CAB-BACK B64.0  BB4.0 11 0374 412 1.30 14.27
2. BTH-CAB-BOTTOM G64.0 1440 8 0.098 0.86 0.33 288
3. BTH-CAB-DOOR-LEFT 3485 4500 12 0157 189 0.54 B.54
4. BTH-CAB-DOOR-RIGHT 395 4800 12 0187 1.89 0.54 G54
5. BTH-CAB-EMD-LEFT 162.0 BOO.D 8 0.097 0er 0.34 3.03
f. BTH-CAB-EMD-RIGHT 162.0 G00.0 9 0.0g7 087 0.34 303
7. BTH-CAB-SHELF 664.0 1440 8 0086 0.76 0.33 2 65
8. BTH-CAB-SHLF-BASE B64.0 162.0 7 0.108 074 0.37 261
9. BTH-CAB-TOP BB4.0 162.0 g 0.108 0.86 0.37 2498
10. DDC-SHELF 928.0 3.0 9 07289 260 1.09 9.a0
11. DDC-SHELF 9280 3110 12 0.289 346 1.09 13.06
12. DDC-SIDE-LEFT a64.0 3110 11 0175 1.83 0.61 668
12. DODC-SIDE-RIGHT a64.0 3110 7 0178 1.23 061 4725
13. GABLE-EMO-LEFT a64.0 3110 9 0178 1.68 0.96 .61
14. GABLE-END-RIGHT a64.0 3110 f 0.175 1.08 0.96 574

4 » \Part summary /

» Select: Settings - Report settings

or

AB
1

Select the Toolbar symbol

The Report layout dialog is shown.
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Report settings - Part surmmary >

Layout  Font
Content
Ayailable Chozen
Length Inches Mo
Length Frac Part / Dezcrption
Width Inches Length ram |
wWidth Frac Wéidth mm i
Taotal Req »» | Tatal Prad
ft / Part me / Part
Toatal 2 Tatal m2
Lire c¢ | Matenial cost /Part
b aterial bl aterial cost Taotal
Thickness mm [arain
Edge
Calurnn widths
Ize default J
Faormat |.-’-'-.ut|:|-fit to contents v
Sart by

() Material [with subheadings and subtotals] - Default
() Line / item number

O Custom

Help Cancel

Content
These boxes show the available fields on the left and the fields already chosen for the report on the right.
» Select an item and use the arrow buttons to move the item to and from the report.

In the following example some fields are removed from the report.

41



Report settings - Part surmmary

Layout  Font
Content
Ayailable Chozen
Length Inches Mo
Length Frac Part / Dezcrption
Width [nches Letigth mm
Wwidth Frac Width mim
Toatal Prad »» | Taotal Req

me F'at

Total fr2 T otal m2

M aterial cost /Part c¢ | Material cost Total
Grain

Edge

Irfi 1

Calurnn widths
Ize default J

Faormat |.-’-'-.ut|:|-fit to contents v

Sart by
() Material [with subheadings and subtotals] - Default
() Line / item number

O Custom

Help Cancel

The report now looks like this:-
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2 Review runs = ] X
Eile Edit View Settings Summaries Help
TBADE A D> s ?
%\ Part summary
Management summary Demo Part edging
Revision 6 : 14 Jul 2023 14:23 . Cptimised by Stephanie
g No Part! Length  Width Total m2/ Total Material cost
Description mm mm Reg Part m2 Total
Part summary
== Total 139 2473 9276
)
Board summery 1. BETH-CAB-BACHK BB4.0 a64.0 11 0.374 412 1427
2. BTH-CAB-BOTTOM GE4.0 144.0 8  0.096 086 288
ﬁ] 3. BTH-CAB-DOOR-LEFT 3495 450.0 12 0157 1.89 G54
Patterm summary 4. BTH-CAB-DOOR-RIGHT 495 4800 12 0187 180 B.54
5. BTH-CAB-EMD-LEFT 162.0 g00.0 8 0.097 087 3.03
% 6. BTH-CAB-EMD-RIGHT 162.0 g00.0 9  0.097 0.a7y 3.03
7. BTH-CAB-SHELF 664 .0 1440 8 0D.096 076 265
Iput summary 8. EBTH-CAB-SHLF-BASE 664 .0 162.0 7 0108 0.7a 261
9. ETH-CAB-TOP 664 .0 162.0 g 0.108 0.86 298
ﬁ 10, DDC-SHELF 9280 =R 9 0289 2 60 9.80
Material summary 11. DDC-SHELF 9280 Ao 12 0.289 346 13.08
12, DDC-SIDE-LEFT a64.0 3110 11 0175 1493 668
B B 12, DOC-SIDE-RIGHT 464 .0 3o 7 0174 1.23 4725
f mm. 13. GABLE-EMD-LEFT a64.0 a1 9 0174 1.468 .61
2l previen: 14, GABLE-END-RIGHT af4.0 a1an B 0175 105 574
Pattern 4 » \Part summary / |
Line type

This box shows the different sorts of information on the report, for example, Report header, column
headings, data. The style of each of these can be changed.

- Click on Line type
- Click off the check box (Use default)
- Select the Font and Background buttons to change the font and background

In the example below the 'Summary title' font and background are changed.
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Report settings - Part surmmary

Layout Faont

Format
Line - ype

Summary title Font: Trebuchet M5,
File names Size: 20

Colurmn headings Use default]
Data

Totalz |
Pattern - part 1D d
Pattern - part dimenzsions
Program information B ackground
Fage numberz

Fant |

Preview

Summary title

k. Help Cancel

The report is now as follows:-
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2 Review runs = O X
Eile Edit View Settings Summaries Help
b o
TBRAPENA D> P s ?
Summaries
B, Part summary Example of part edging
Management summary Demo Part edging
Revision 6 : 14 Jul 2023 14.23 ;. Cptimised by Stephanie
g No Part! Length Width Total m2/ Total Material cost
= Description mm mm Req Part m2 Total
ark summary
% Total 139 24.73 92,76
Boaid ey 1. BTH-CAB-BACK BG40 5640 11 0374 412 14.27
2. BTH-CAB-BOTTOM 6640 1440 9 0095 086 298
ﬁ] 3. BTH-CAB-DOOR-LEFT 3485 450.0 12 01587 1.89 G.54
Pattem summary 4. BTH-CAB-DOOR-RIGHT a5 4500 12 01587 1.88 £.54
5. BTH-CAB-EMD-LEFT 162.0 G000 9 0097 0.87 3.03
% G. BTH-CAB-EMD-RIGHT 162.0 G000 9 0097 0.87 3.03
R 7. BTH-CAB-SHELF R4 .0 1440 8 0.096 0.76 2.R8
2. BTH-CAB-ZHLF-BASE 6640 162.0 7 0108 0.ra 281
ﬁ 9. BTH-CAB-TOP GE4.0 162.0 8 0.108 0.86 2498
10. DODC-SHELF 928.0 311.0 9 0289 2.60 9.80
Material summary 11. DDC-SHELF 9280 3110 12 0288 346 13.06
12. DDC-SIDE-LEFT 264.0 3110 11 0175 1.83 G.68
%% 15. DDC-SIDE-RIGHT 264.0 3110 7 0175 1.23 425
A 13, GABLE-END-LEFT 5640 3110 g 0175 158 861
Preview
14, GABLE-END-RIGHT ag4.0 3110 g 0172 1.0 8.74
Pattern 4 » \Part summary / |

Column widths
To change the column widths:-

- Click off the 'Use default' box
- Select the type of column width

User defined
Auto fit to contents
Auto fit to display

In this example the column width is set to 'User defined'.

Whilst the grid widths can be changed at this dialog it is often easier to do this at the Report screen via the
options on the 'View' menu.

Using the View menu to customise reports

There are several options at the 'View' menu to help customise the report. For example:-
To manually change the column widths.

» Turn on the Grid labels (these act as grab handles for the columns).
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2 Review runs

Eile Edit View Settings

D A&

Summaries  Help

44> PlgEm?

Summaries

8

s

Part summary

u;]

Board zummary

iy

Pattern summary

i

Input surmrary

M aterial summary

B B
] B

Pattern preview

-

Pattern

Management summary

Zoom

Part summary

Example of part edging

Demo Part edging

Bﬂa@@qq 14 JL.|J| 2023 |14:23 : Optimis?d by StephaTie

4

[ 1 [ 2 [ —
No Part! Length Width _Total m2/ Total Material cost
Description mm mm Req Part m2 Total
Total 139 24.73 92.76
|| 1. BTH-CAB-BACK BB40 5640 11 0374 412 14 27
& 2 BTH-CAB-BOTTOM 6640 1440 9 0096 086 298
B 3. BTH-CAB-DOOR-LEFT 3495 4500 12 0157 189 B.54
|| 4. BTH-CAB-DOOR-RIGHT 3485 4500 12 0157 189 B .54
] 5. BTH-CAB-EMD-LEFT 1620 BOO.O 9 0.097 087 3.03
h— B. BTH-CAB-END-RIGHT 1620 BOO.0 9 0097 087 3.03
B 7. BTH-CAB-SHELF B640 1440 8 0096 076 265
|| 8. BTH-CAB-SHLF-BASE G640  162.0 7 0408 075 261
B 8. BTH-CAB-TOP 6640  162.0 8 0108 086 298
| 10, DDC-SHELF 8280 3110 9 0289 250 880
|| 11, DDC-SHELF 8280 3110 12 0283 346 13.06
| 12, DDC-SIDE-LEFT 5640 3110 11 0175 183 558
| | 15 DDC-SIDE-RIGHT 5640 3110 7 0175 123 425
|| 13, GABLE-END-LEFT 5640 3110 9 0175 158 BB
14, GABLE-EMO-RIGHT 640 3110 § 0175 105 574

» \ Part summary /

* Move the mouse over the junction of a grid label to alter the column width

* Hold down the mouse button to drag the column to change the width

In the following example the column widths have been altered.
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2 Review runs = ] X
Eile Edit View Settings Summaries Help
b o
FTEBAPVEKA D> PIg®?
Summaries
B, Part summary Example of part edging
Management surmmary DemO part edglng
| | | Relvision6| 14 Jul 2E|123 I=hRes Optirl"nised by StephalTie
1 2
g | | No Part! Length Width Total m2 Total Material cost
PRSI Description mm mm Req Part m2 Total
'E“ | Total 139 2473 92.76
Board zummary
: 1. BTH-CAB-BACK AE4.0  964.0 11 0.374 412 14 27
@ | 2. BTH-CAB-BOTTOM 664 .0 1440 9 0.096 0.86 2498
Pattem surmay || 3. BTH-CAB-DOCR-LEFT 3435 4500 12 0.157 1.89 B.54
| 4. BTH-CAB-DOOR-RIGHT 395 4800 12 0.1a7 1.89 G54
% | 2. BTH-CAB-EMD-LEFT 162.0 600D g 0.0g97 0.a7 2.03
| g, BTH-CAB-ENMD-RIGHT 162.0 g00.0 9 0.097 0.av 3.03
Inpulstmmant | 7. BTH-CAB-SHELF 664 .0 144.0 a 0.096 076 2 65
| 2. BTH-CAB-ZHLF-BASE B64.0 162.0 7 0.108 0.7a 261
ﬁ | 9. BTH-CAB-TOP 664 .0 162.0 a 0108 0.86 2498
M aterial summary | 10. DDC-SHELF 9280 3110 q 0.289 260 .80
| 11. DDC-SHELF 9280 3110 12 0.289 348 13.06
%% N 12, DDC-SIDE-LEFT ag4.0 3110 i 0174 1.93 g.68
BT ) | 12. DODC-SIDE-RIGHT 4640 3110 7 0175 1293 4725
sempEvew [ 13, GABLE-END-LEFT 5640 3110 g 0.175 158 B A1
@ L 14, GABLE-END-RIGHT ag4.0 3110 ] 0174 1.08 .74
Pattern 4 » \Part summary / |

The view menu can also be used to add grid lines.

» Select: View - Grid lines
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2 Review runs = O X
Eile Edit View Settings Summaries Help
TBRAPENA D> P s ?
Summaries
B, Part summary Example of part edging
Management surmmary DemO part edglng
Revision 6 : 14 Jul 2023 14:23 ;. Cptimised by Stephanie
g No | Part} Length | Width | Total m2 | Total | Material cost
= Description mm mm | Req Part m2 Total
ark summary
% Total 139 24.73 92,76
Hoadbtnary 1. | BTH-CAB-BACK f64.0 a64.0 11 0.374 412 14.27
2. | BTH-CAB-BOTTOM G640 14410 9 0.096 (.86 248
ﬁ 3. | BTH-CAB-DOOR-LEFT 34895 | 4500 12 0157 1.89 5.54
Pattern summary 4 | BTH-CAB-DOOR-RIGHT 3495 | 4500 12 0.157 1.89 §.54
5. | BTH-CAB-END-LEFT 162.0 G000 q 0.097 0.87 3.03
% 6. | BTH-CAB-END-RIGHT 162.0 G000 9 0.0a7v 0.87 3.03
R 7. | BTH-CAB-SHELF FE .0 14410 g 0.096 .76 2 B8
3. | BTH-CAB-SHLF-BASE f64.0 162.0 7 0.108 075 2.61
ﬂ 9. | BTH-CAB-TOP G640 162.0 g 0.108 (.86 208
10. | DDC-SHELF 8280 3110 g 0.289 2.60 980
Material summary 11. | DDC-SHELF 928.0 311.0 12 0.284 346 13.06
12, | DDC-SIDE-LEFT 5640 3110 11 0175 1.83 G.68
g% 15. | DDC-SIDE-RIGHT 5264 .0 3110 7 0175 1.23 425
Pl 13. | GABLE-END-LEFT 564.0 | 311.0 g 0.175 1.58 g.61
14, | GABLE-EMD-RIGHT a64.0 311.0 f 0175 1.08 2.74
Pattern 4 » \Part summary / |

Default report settings

On the report settings dialog there is a box labelled 'Use default'. If this is checked the default settings for a
report are used. These defaults apply to ALL the reports where this box is checked.

To change the default settings themselves, at any report:-
+ Select: Settings - Default settings

The default settings are shown.
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Default settings X

Farmat
Line - type

Summary title Font: Tahoma, Size:; 20
File names
Colurmn headings
Subheadings
Data

[nformation boxes
Subtatals

Totalz

Pattern - part D
Pattern - part dimenzsions Background

Fant

Prewview

Summary title

Colurnt widthz

Farmat Auta-fit to digplay o

Help Cancel

Note - The content of each report is also set as a default - this default is set by the program and cannot be
changed.

Printing reports

To print a report (or pattern).
* Move to the report/pattern

- Select: File - Print (Ctrl P)
or

—

=

This prints the current report.

Select the ToolBar option

To print all the reports and/or patterns.

» Select: File - Print summaries

The program prompts with a dialog to select the items to print.
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Printed - Default

Summaries
Available

b anagement zummary
Pattern zummary

Part surmmary

Board summary

Cutting dimensionz

Chozen

b anagement zummary
Pattern summary

Part zummary

Board summary

[nput summary o | Input summary

b aterial surnmary Pattern drawing
Preview Part sizes for pattern
Pattern drawing Cutting dimensgionz
Part zizes for pattern c¢ | Preview

b aterial summary

Form feed after reports ]

k. Help Cancel

» Use the arrow buttons to move the reports from 'Available' to 'Chosen'.

The program retains the choices for future sessions.

(The default reports to print are set at the 'Review runs Parameters' dialog).
There are options on the File menu to alter the Page Setup and Printer Setup.

* File - Page setup
* File - Default Page setup

The page setup can apply separately to each report.

* Move to the report
» Select: File - Page setup

50



Page setup - Management summary >

Paper

B

Crienkation Margins (Millimetres)

Parktr aik 5 5

Landscape 5 5

Cptions Header|Fooker
Black and white Al pages
Prink: ko Fik

Frint grid lines Centred

Printer

Prinker...

Help Cancel

These options control the paper size, orientation and basic report items such as the banner and page
numbers.

- Check the 'Use default' settings to apply the default settings. The default settings apply to all reports where
'Use default' is checked.

The default settings can be changed via the option: File - Default page setup. Any changes to the default
settings apply to all reports using the default settings.

File - Print setup - This is not often needed since the printer can be changed at the standard Print dialog
which always pops up before printing reports and the page layout is best set at the 'Page setup' or 'Default
page setup' dialogs.

Review runs parameters

The operation of Review runs can be customised via 'Review runs parameters'. At the Review runs screen:-

» Select: File - Parameters
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Report settings - Pattern drawing >
Font  Picture  Options

igw style Colour coding Mt

Colour coding

Colaur - part | | ik

[
Colour - recut part | | w '
Colour - wazte and saw blade | | v
Colour - edging | | -
Frint Colowr coding o

Help Cancel

There are options to alter the pattern display and how patterns are shown (e.g. monochrome or colour).
The Reports can be set to show waste percent or yield and whether large values are rounded or not.
The Review runs parameters help describes each setting in detail.

The following example shows the pattern diagram using colour codes rather than monochrome.
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2 Review runs - a x

Eile Edit View Settings Summaries Help

RO BREIMA D> PIg® ?

Pattern 1 of 8

e

Management summary Demo Part edging
Revision 6 : 14 Jul 2023 14:23 . Cptimised by Stephanie

s

Board: MFC18-TEAKIO1 Waste: 5.74% Size: 2440 0% 12200x 18.0
Part summary MWaterial MFC18-TEAK Eoards: 1
B )
o I/ o [=2) [=) h
— h h = = =
Board zummary iy oy oy = N

iy
=
>
-
=
~

Pattern summary

tn

564 564 564 564144
| g %] 5] [#3] %]
HpuUt SUmmany E 5 600 % % % %
ﬂ = w3 3 i - 3
b aterial summar I~ 600 : 450 450 450] 450
b = = = =
i S 5 60O 2 600l 9 e00l® 9 600
B
Felzniercy Saw blade thickness: 4.8
@ Rearrip trim (inc blade): 10.0 Rear crosscut trim {inc blade): 10.0 Retrim {inc blade). 5.0 Grain direction. =
Pattem < » \Pattern £ Partz £ Cutting dimensions / |

6. File Management

The File management options are for organising and maintaining the files created by Magi-Cut V12 Express.
At the main screen:-

» Select: File - File Management
or

Select the Toolbar option

The file management screen is displayed:-
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X File management - Cutting lists o O %

File Edit View Help

TeXBREH=?

C:\Magi-Cut W12 Express\Datah

File Title Size Modified

Demo cutting list Example of basic cutting list 1KB 24/05/2023 0924

Dema large list E=ample of large cutting list 14/1 45
Drema multiple boards Example of multiple boards 3KB 24/05/2023 0319
Demo part edging Example of part edging 2KB 24/05/2023 0318
Demo part graining Example of part graining 2KB 24/05/2023 09:27

File: Demo large list

Title: Example of large cutting list

Drescription M aterial Length “wiidth Gty 3. Edging  Infol Info 2 Info 3
1. BTH-CAE-BACK. MFC18-TEAK EE4.0 BE4.0 4 N 0000
2 BTH-CAB-BACK. MFC18-EBONY 464.0 BE4.0 3 N 0000
3 BTH-CAB-BOTTOM MFC18-EBONY 464.0 144.0 3 N 0000
4 BTH-CAB-BOTTOM MFC18-TEAK EE4.0 144.0 4 N 0000
5 DDCEBOTTOM H&RDBOARD-4MM 964.0 BE4.0 4 N 0000
E. BTH-CAB-DOOR-LEFT  MFC18-TEAK 3495 450.0 4 N 0000
7.BTH-CAB-DOOR-LEFT ~ MFCI8-EBOMNY 2495 450.0 3 N 0000
8 BTH-CAB-DOOR-RIGHT MFC18-TEAK 3495 450.0 4 N 0000
9. BTH-CAB-DOOR-RIGHT MFCI18-EBOMNY 2495 450.0 3 N 0000
MNUM
At the left the tree shows the different types of file used by the software.
Cutting lists
Optimisations
- Click on a category to see the files
The pane at the foot of the screen shows the contents of the currently selected file.
Copy files
» Select type of file in the left pane
+ Select one or more files
» Select: File - Copy
or
Select the Toolbar option
The program prompts to select a file name and/or directory to copy the files to.
Copy - Dema large list =

Filenarme [MEltEls[=8/E

Path C:hag-Cut W12 ExpressiDatat

Help Cancel

Use the list box to select a path
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+ Select OK to finish

Delete Files

To permanently remove files.
Select type of file in the left pane
+ Select files

» Select: File - Delete
or

Select the Toolbar option
The program prompts to confirm delete.
Notes

For optimisations (runs) the program deletes all the files associated with the run. A run consists of several
different files as well as the main run file.

Examplel.ctt - cutting list
Examplel.brd - board list
Examplel.ptn - patterns
Examplel.btc - internal file
Examplel.cut - cutting instructions

Print (File management)

To print the current list of files, at the File Management screen:-

» Select: File - Print (Ctrl P)
or

—

=

The program prints the current list.

Select the Toolbar symbol

To set up the printer: Select: File - Print setup
The program displays a standard Windows dialog to change the printer settings.

To print with a preview: Select: File - Print Preview

7. Backup and Restore

Once the program is in regular use - make sure the System Administrator includes the program directory in
the regular system backups. This is the directory that was set up during the install process, for example:-

c:\Magi-Cut V12 Express

The program and all the data are typically stored in this directory/folder with data and other information in
sub-directories, for example:-

c:\Magi-Cut V12 Express\Data
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This PC » Windows (C:) » Magi-Cut V12 Express »

Search Ma;

Mame B Date modified Type Size
Data 14/07/2023 14:57 File folder
Guides 14/07/2023 11:19 File folder
lcons 03/07/2023 10:52 File folder
Images 14/07/2023 11:19 File folder
SlideShow Date created: 03/07/2023 10:52
Size: 3.60 MB
2 Backup Files: opt01-01, opt01-02, opt01-03, optd1-04, opt01-05, ... n 2,021 KB
2 2 Batch 11/07/2023 15:36 Application 2,509 KB
| Bsrgui 11/07/2023 15:36 DLL File 3,836 KB
| Berlib 11/07/2023 15:36 DLL File 3,826 KB
| Bsrmch 11/07/2023 15:36 DLL File 2884 KB
Backup

The program includes a 'Back up' option. This takes a copy of the current data and stores it in a single

compressed file.

'Back up' can be used to take a snapshot of the data for archiving or testing and as a regular back up - but it

should not replace a regular back up set by the System Administrator.

At the main screen:-

» Select: File - Back up

or

(®)

The Backup dialog is displayed.

Select the Toolbar option

Back-up

Path far back-up

Filename

Statuz

C:8UserstStephaniesJneDrivesD ocumentsy

2023-07-14 1533 Magi-Cut %12 Expreszs Backup

Cancel

The 'Path for back up' defaults to "My documents’. Use the list box to select an alternative path.

The 'File name' box contains a default name based on the date and time. Click on the
field to edit the name or enter a different name.
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« Select OK to confirm

The data is backed up to a single file (e.g. 2023-06-23 Magi-Cut V12 Express Backup.bkp ). This is a 'zipped'
file containing all the files in a compressed form.

When back up is complete the program prompts with a message showing number of files and
overall size.

» Select OK to finish

Note - The 'Back up' option is also available at the File management screen.
Restore

To restore backed up data. At the main screen:-

» Select: File - Restore

(If there are no back up files in the current back up directory the program warns with the message 'No entries
found' - select OK to continue).

The program prompts with a list of Back up files.

2 Restore >

Date
B- 2405/
% 2023-05-30 1631 Magi-Cut W12 Express Backup 30/05/2023 16:32
% 2023-07-05 1137 Magi-Cut W12 Express Backup 05/07/2023 11:38
Find [ Filter

Help Cancel

- Use the Browse button to choose from a different back up directory.

+ Select OK to continue

Any existing data is replaced.

The program automatically takes a back up of the existing data before replacing it.
+ Select Yes to continue

When the restore is complete a message 'Restore finished' is shown on the screen.

8. Access to Help

There are a range of Help options when using the program.

At each screen or dialog there is typically a help button and usually Help choices on
the menu.
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? - click the help symbol

rq

Help

Contents

Main screen
Using help

Licence agreement

About
Check for updates

www.magi-cut.co,uk
Ll

o

- choose an option from the Help menu

Where the cursor is located at a field or check box press F1 to bring up help about
that item.

Title | Example 1

- press [ F1 ] for help

On most dialogs a help button is provided.

- click on button for more details

B =7

Optimise

- Place the cursor over an object to view a tooltip

Help is shown in a Window that sits on top of the program window. The Left pane shows
the Contents and the Right pane the current topic.
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E‘éj W12 Express Help

-IE = '

Hide  Eack  Print  Options
Contents  Search

=@l
3

Q Optimizing parameters

i -@ Syztem parameters
Review ming

@ Filz Managament

Q Back-up and Restore

-@ Sypstem check

@ Errars

Home > Cutting lists = Parts = Title - Cutting list #
Title - Cutting list 1

Field for a description of the list

At the top of the Cutting list screen there is a box for the description used when optimising the cutting
list. These are called the "Cutting list properties”.

2 Cutting list - Basic part list

File Edit View Optimise Help

POOEE ERw B & ?

Title Example of basiz part list Pararneters ]
Parts
Drescription I aterial Length

Global WHITE GLOSS 18MM

T 1 WHITE GLOSS 18MM 12000

2 2 WHITE GLOSS 18k 12800

3 3 WHITE GLOSS 18MM 790.0 v
41( 4 WHITE G MSS 18k4RA RANN

See also

The Toolbar and Help menu at the top of the Help screen gives access to other options, for example, Print.

On most topics there is a 'See also' button - this shows other links relevant to the topic.

- Print any help topic by using the Print option from the menu at the top of the screen.

Errors

If a problem occurs this is typically reported as an Error message on-screen. For example:-

Error X
kMezzage Description
Data not corect - part too large [38020] Fiun Demo cutting list Part 1. PRT-007 -4
Drata not correct - part oo small [28021] Fun Demo cutting lisk Part 2. PRT-002-6
Cancel Print Help
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Optimise x

Meszage Drescription
Drata not correct - no boards [38007] CHIFEOARD-18MM
Data not corect - no boards [38001] bAPLE W D003k

Continue Cancel Print Help

When working with cutting lists, runs etc. problems are often caused by missing or wrong data. In these
cases the start of the message indicates the type of problem and the rest of the message describes the
missing data.

- select the Help button for details of the error

[ V12 Express Help = O X
Hide  Bacl Print  Options

Contents  Search

Home = Ermrors = Data not cormrect - no boards

Data not correct - no boards

i@ Main screen

-4 Cutting lists May occur when optimising a cutting list

L]--@ Optimising parameters .

@ System parameters One or more of the materials does not have any boards.

- Review uns g : , ;

5@ File Management The message also indicates which materials are causing the problem

28 4 gaCk'uD Endkﬂestore Where the message is caused by a material code missing from the Master board list a default board
@ System ches is entered in the board list. These default entries need to be manually edited with the correct details
@ Errors for each board size.

Check the Master board list and make sure that the material has at least one board size set up

All the error messages are included in the Help file and can also be accessed from the Help menu or by
searching the help. Each error also has a fixed number to help identify it.

- To search for a phrase like: Data not correct - No boards enclose the phrase in quotes: "Data not correct -
No boards"

- Some errors messages can have several different causes - check the topic carefully to identify the correct
cause.

After the error message

Where the error is advisory the program may continue to complete the operation - in this case check the
results carefully.
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In most cases the error prevents the operation and the program moves back to the previous screen.

System Check

This option performs basic checks on the hardware, operating system and software installation.

It is useful for investigation of problems with the software not running and problems with the Licence.

At the main screen:-
» Select: Tools - System Check

The System Check Report is displayed

& System check ¥12.00

Licence / Programs
Fulllicence

Program folder. C:\Wagi-Cut W12 Expresst
« Language: English (UK} (v12.000.0) Update
« Help: English (LK)

Upload Frint

System Refresh Upgrade Log out
. « Serial number._ « Version: V120 « Level Express
Security
Company name: Magi-Cut Software Ltd
Verify files « Licence: Fulllicence « Software support expires: Jun 2024
Minimum Requirements Cloud licence seats: 1(ID0773)
MWeter reading: 14 Verification code: Twi-CXi-nYs
Network
Programs
« Version ¥12.000.0  pdates Version date: 01 Jun 2023

Help

Exit

Some of the individual checks are available on the Check menu.

The Initial screen shows the following information.

Version number and directory checked
Program and language status

Licence details

System details

Memory details

Disk drives

If an item shows Ok the item is Ok for running the program
If there is an X check the item as it may be a problem
To print a system check report:-

» Select: File - Print
or
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- Select the print button

Notes

The System check option can also be run as a stand-alone Program. It is in the program directory (where the
program was installed) and is named 'Check.exe' - this can be useful where the program is not running. The

'Check' program does not require a licence.
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